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 اجرای برنامه نمایشی از کدام اسلاید انجام می شود؟ slide current From با استفاده از گزینه .1

 اسلاید اول -الف 

 اسلاید میانی -ب 

 اسلاید آخر -ج 

 ️✔ اسلاید جاری -د 

 .یک ........... گویند که با پسوند ............ ذخیره می شود PowerPoint به هر فایل تولیدی در .2

Doc- document - الف 

Pptx- presentation - ب ✔️ 

pxt- slide - ج 

xls- spreadsheet - د 

 برای ایجاد انیمیشن کاربرد دارد؟ PowerPoint کدام منو در نرم افزار .3

 ️✔ Animations - الف

Slide Show - ب 

 Design - ج

 Review - د

 برای درج متن از چه روشی استفاده می شود؟ .4

 Format - الف

Text Box - ب ✔️ 

 بدنه ی اسلاید -ج 

 یک شی خارجی -د 

 .به نحوه قرار گرفتن محتوای اسلایدها ....... می گویند .5

Slide Design - الف 

Slide Layout - ب ✔️ 

Slide Sorter - ج 

Color Schemes - د 

 استفاده می شود؟ Transition انبندی کردن تعویض اسلاید از کدام گروه سربرگجهت زم .6

Advanced Slide - الف✔️ 

 Preview - ب

Transition to this Slide - ج  

 Animation - د

 سریعترین و راحت ترین روش برای ایجاد برنامه نمایشی کدام است؟ .7

 file از منوی New انتخاب گزینه -الف 

 ️✔ N+Ctrl کلیدهایفشردن  -ب 

 M+Ctrl فشردن کلیدهای -ج 

 file از منوی Document Recent انتخاب گزینه -د 

 .قابلیت کوچک نمایی برای مشاهده کل اطلاعات به صورت یکجا را ....... می گویند .8

Zoom in - الف 

Zoom out - ب  

Font Size - ج 

fit to window - د✔️ 
 .نمودار و .... در اسلاید چه می گویند به نحوه قرار گرفتن متن، تصویر، .9

Slide layout - الف ✔️ 

Slide Design - ب 

 Themes - ج

 Templates - د
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از کدام گزینه استفاده  Design برای تغییر رنگ و طرح زمینه و قلم ، از طرح های پیشنهادی آفیس، از سربرگ .10

 می شود؟

  Themes - الف

Background Style - ب✔️ 

 Color - ج

 Effects - د

 می توان مجموعه ای از تصاویر را به صورت آلبوم ایجاد کرد؟ Insert توسط کدام ابزار در سربرگ .11

 Picture - الف

Clip Art - ب 

Photo Album - ج ✔️ 

 Shapes - د

 کدام گزینه برای تنظیم گذار اسلایدها استفاده می شود؟ .12

 Animate - الف

Advanced Slide - ب 

Slide Show - ج 

Slide Transition - د ✔️ 

 اگر بخواهیم متحرک سازی یک شی همراه با متحرک سازی قبلی اجرا شود، کدام گزینه را انتخاب می کنیم؟ .13

On click - الف 

start With Previous - ب ✔️ 

After Previous - ج 

 Direction - د

 از کدام گزینه برای افزودن جدول به اسلاید استفاده می شود؟ .14

Insert / New Slide  الف -گزینه 

 ️✔ Table / Insert گزینه -ب 

 Diagram/ Insert گزینه -ج 

 جدول را نمی توان به اسلاید اضافه کرد -د 

 می توان جلوه حرکت به موضوعات بر روی مسیر داد؟ Animation در کدام قسمت از سربرگ .15

 Entrance - الف

 Emphasis - ب

 Exit - ج

Motion Path - د ✔️ 

 در کدام نما نمی توان متن یا تصویر به اسلاید اضافه نمود؟ .16

Note Page - الف 

Slide Sorter - ب ✔️ 

 Normal - ج

 Outline - د

 با فشار کدام کلیدها می توان یک کپی از اسلاید را بعد از همان اسلاید ایجاد کرد؟ .17

Ctrl + C - الف 

Ctrl + X - ب 

Ctrl + V - ج 

Ctrl + D - د ✔️ 

، کدام گزینه زیر زمان تاخیر برای حرکت موضوع را می توان Timing و در قسمت Animation سربرگدر  .18

 وارد کرد؟

 Start - الف

 ️✔ Delay - ب
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 Speed - ج

 Repeat - د

 چیست؟ PowerPoint بطور پیش فرض نام فایل نمایش در .19

 1Book -الف 

 1Presentation -ب ️✔

 1Slide -ج 

  Ppt - د

 نماهای زیر می توان متن ، تصویر و یادداشت به اسلاید اضافه کرد؟ در کدام یک از .20

Slide Sorter - الف 

 Draft - ب

 ️✔ Normal - ج

Slide Show - د 

 برای خاتمه دادن به نمایش اسلایدها کدام کلید را باید فشرد؟ .21

 E - الف

 ️✔ esc - ب

 Home - ج

 End - د

........ را همزمان از صفحه کلید فشرداده و روی آخرین اسلاید کلیک می جهت انتخاب اسلایدهای هم جوار کلید  .22

 .کنید

 ️✔ Shift - الف

 Ctrl - ب

 Alt - ج

 Tab - د

 برای ایجاد فایل جدید در پاورپوینت کدام کلیدهای ترکیبی را می فشاریم؟ .23

Ctrl+S - الف 

Ctrl+F - ب 

Ctrl+N - ج ✔️ 

ctrl+O - د 

 ء و اشکال گرافیکی کدام گزینه را انتخاب می کنیم؟به منظور سه بعدی کردن اشیا .24

Shadow slide - الف 

3 -D style - ب ✔️ 

Arrow style - ج 

Insert clip art - د 

 جهت شماره گذاری اسلایدها چه مراحلی را باید طی کرد؟ .25

Insert/Header and footer/Slide number - الف ✔️ 

View/Zoom - ب 

View/Slide show - ج 

Header and footer/Slide number/ - د 

 کدام گزینه برای ایجاد اسلاید در پاورپوینت صحیح است؟ .26

Blank presentation - الف  

Form design template - ب 

 Bullet - ج

New Slide - د✔️ 
 .در چیدمان اسلاید برای درج .......... می باشد table Insert استفاده از دکمه .27

 ️✔ جدول -الف 
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 فیلد -ب 

 رکورد -ج 

 نمودار -د 

برای چاپ اسلاید از منوی فایل گزینه ....... را انتخاب کرده و در پنجره باز شده برای چاپ همه اسلایدها گزینه  .28

 ........ را انتخاب می کنیم؟

Print/Selection - الف 

Print / All - ب ✔️ 

Print/Current slide - ج 

Print/Custom show - د 

 اسلاید با کدام گزینه امکان پذیر است؟ عمل انتقال .29

 Copy - الف

 ️✔ Cut - ب

 Print - ج

 Delete - د

 چیست؟ Slide Hide کار گزینه .30

 حذف اسلاید -الف 

 ️✔ مخفی کردن اسلاید -ب 

 انتقال اسلاید -ج 

 درج اسلاید -د 

 برای شماره گذاری اسلایدها از کدام گزینه استفاده می شود؟ .31

Slide Number - الف ✔️ 

Num bering – ب 

Number Slide - ج 

Page Slide - د 

 در کدام نما می توان ترتیب اسلایدها را تغییر داد؟ .32

notes page - الف 

 normal - ب

slide sorter - ج ✔️ 

slide show - د 

 اجرای برنامه نمایشی از کدام اسلاید انجام می شود؟ slide current from با استفاده از گزینه .33

 اسلاید اول -الف 

 ️✔ اسلاید جاری -ب 

 اسلاید آخر -ج 

 اسلاید میانی -د 

 از طریق کدام دستور تعداد تکرار صوت مشخص می شود؟ .34

 start - الف

 delay - ب

 speed - ج

 ️✔ repeat - د

 کدام یک از موارد زیر، یک برنامه نمایشی خالی ایجاد می کند؟ .35

Autocontent Wizard - الف 

 Template - ب

Open An Existing Presentation - ج 

Blank Presentation - د ✔️ 
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 را چه می نامند؟ PowerPoint های ایجاد شده در محیطفایل .36

 ️✔ presentation - الف

 book - ب

 document - ج

 chart - د

 با چه ابزاری می توان در درون اسلاید یک چهارضلعی ایجاد کرد؟ .37

 Line - الف

 Oval - ب

 ️✔ Rectangle - ج

 Arrow - د

 .هر فایل ارائه مطلب از چندین صفحه تشکیل شده است که به هر یک از این صفحات ....... می گویند .38

 الیه -الف 

 ️✔ اسلاید -ب 

 سند -ج 

 کاربرگ -د 

 .هر فایل ارائه مطلب حداقل ....... اسلاید دارد .39

 2 -الف 

 3 -ب 

 ️✔ 1 -ج 

 4 -د 

نرم افزار باز می شود که به وسیله آن می توان به امکانات لازم برای مدیریت با کلیک بر روی این دکمه منوی  .40

 .ها دسترسی پیدا کردفایل

 insert - الف

 ️✔ File - ب

 Home - ج

 Options - د

 .است PowerPoint این نوار ابزار شامل دستورات پرکاربرد نرم افزار .41

 نوار عنوان -الف 

 ️✔ نوار ابزار دسترسی سریع -ب 

 ریبون -ج 

 های کنترلیدکمه -د 

ی پنجره است در راستای توانیم اسلایدها را در زمانی که محتوای آن بزرگتر از اندازهبا استفاده از .......... می .42

 .عمودی و افقی پیمایش کنیم

 ️✔ نوارهای پیمایش -الف 

 نوار عنوان -ب 

 ناحیه ویرایش اسلاید -ج 

 نوار وضعیت -د 

 توانیم آن را اصلاح کنیم؟اسلاید فعال میدر کدام ناحیه از  .43

 ناحیه اضافه کردن نکات گوینده -الف 

 ️✔ ناحیه ویرایش اسلاید -ب 

 فضای کاری نرم افزار -ج 

 لیست اسلایدها -د 

قرار دارد و لیستی از  PowerPoint ی نرم افزاربه صورت عمودی در سمت چپ یا راست پنجره .......... .44

 .دهدفایل ارائه مطلب را نشان میاسلایدهای موجود در 

 نوار اسلاید -الف ️✔
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  نوار پیمایش -ب 

 ناحیه ویرایش اسلاید -ج 

 نوار وضعیت -د 

 .شودنمایی اسلاید استفاده میاز ابزار .......... برای بزرگنمایی یا کوچک .45

 ️✔ Zoom - الف

 Undo - ب

 Redo - ج

 Save - د

 .شودای بازگشت به اسلاید قبل و رفتن به اسلاید بعدی استفاده میابزارهای .......... و .......... بر .46

Next Slide - الف 

Previous Slide - ب 

 Comments - ج

previous slide و Next slide - د ✔️ 

 .شودهای مختلف اسلاید استفاده میبرای ایجاد .......... در قسمت comments از ابزار .47

 ️✔ یادداشت -الف 

 نویسیفرمول  -ب 

 پاورقی -ج 

 ویرایش اسلاید -د 

 .شوداستفاده می PowerPoint از نمای .......... برای جابجایی و مدیریت کردن اسلایدها در .48

Slide Sorter - الف ✔️ 

 Normal - ب

Reading view - ج 

Slide show - د 

کنندگان در جلسه حی شده به شرکتتوان برای نمایش اسلایدهای طراافزار میاز نمای ................. در نرم .49

 .استفاده کرد

Slide Sorter - الف 

 Normal - ب

Reading view - ج 

Slide show - د ✔️ 

 .توان استفاده کرداز نمای ........ برای خواندن اسلایدهای طراحی شده می .50

 Normal - الف

Slide show - ب  

Reading view - ✔️ج 

Slide sorter - د 

 شود؟از چه کلیدهای ترکیبی استفاده می file ن منویبرای باز کرد .51

Alt +f - الف ✔️ 

Alt +f1 - ب 

Ctrl +f - ج 

Shift +f - د 

 شود؟های زیر برای ذخیره کردن فایل ارائه مطلب استفاده نمیاز کدام یک از گزینه .52

  Save و انتخاب گزینه File یاز دکمه -الف 

 دسترسی سریعاز نوار  Save استفاده از گزینه -ب 

 S + Ctrl استفاده از کلیدهای ترکیبی -ج 

 Save گزینه Home از ریبون -د ️✔
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 .دهیمافزار، عملیات ....... را انجام میبرای تغییر نام کاربر استفاده کننده از نرم .53

 ️✔ name User گزینه General و قسمت options گزینه file از منو دکمه -الف 

 name User گزینه proofing و قسمت options گزینه file از منو دکمه -ب 

 name User گزینه Advanced و قسمت options گزینه file از منو دکمه -ج 

 name User گزینه language و قسمت options گزینه file از منو دکمه -د 

 کدام راه برای باز کردن یک فایل ارائه مطلب مناسب است؟ .54

 ✅ open گزینه file از منو دکمه -الف 

 save گزینه file از منو دکمه -ب 

 New گزینه file از منو دکمه -ج 

 share گزینه file از منو دکمه -د 

 چیست؟ PowerPoint سریع ترین راه برای باز کردن یک فایل ارائه مطلب در نرم افزار .55

 Ctrl+s - الف

 Ctrl+m - ب

 ✅ Ctrl+o - ج

 Ctrl+c - د

 کدام گزینه مناسب است؟ PowerPoint 2013جهت خروج از نرم افزار  .56

 3F+Altکلید های ترکیبی  -الف 

  Exit گزینه File دکمه -ب 

 W + Ctrl کلیدهای ترکیبی -ج 

 4F + ALTکلیدهای ترکیبی  -د ✅

 .جدید به سربرگ ........ و گروه ........ گزینه ......... را انتخاب می کنیم Slide برای ایجاد یک .57

 ✅ HOME> SLIDE > NEW SLIDE - الف

 HOME > NEW > SLIDE - ب

 View > SLIDE > NEW SLIDE - ج

 DESIGN > NEW > NEW SLIDE - د

 فشردن چه کلیدهایی است؟ slide سریع ترین راه برای ایجاد یک .58

 CTRL +N - الف

 ALT +M - ب

 ✅ CTRL +M - ج

 SHIFT +M - د

 .اسلایدهای شروع که شامل عنوان و زیر عنوان است استفاده می شوداز ....... به منظور ایجاد  slide در چیدمان .59

 ✅ TITLE SLIDE - الف

 TITLE AND CONTENT - ب

 SELECTION HEADER - ج

 TITLE ONLY - د

 ها از چیدمان ....... برای نگهداری عنوان و نگهداری محتوای غیرمتنی استفاده می شود؟ slide در چیدمان .60

 Title slide - الف

 ✅ Title and content - ب

 Title only - ج

 Section header - د

 توانیم به صورت دلخواه طراحی کنیم؟ای نیست و میاین چیدمان شامل هیچ نگه دارنده .61

 Title only - الف

 ✅ Blank - ب

 Title slide - ج

 Two content - د
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 توان استفاده کرد؟ای میبرای انتخاب چند اسلاید از چه دکمه .62

 .برای انتخاب یک اسلاید فقط باید بر روی آن در پنل اسلاید کلیک می کنیم - الف

 .را نگه داشته و روی اولین و آخرین اسلاید مورد نظر کلیک می کنیم Ctrl برای انتخاب چند اسلاید متوالی -ب 

✅ 

 .رد نظر کلیک می کنیمرا نگه داشته و روی اسلایدهای مو Shift برای انتخاب چند اسلاید غیر متوالی کلید -ج 

 .را نگه داشته و روی اولین و آخرین اسلاید مورد نظر کلیک می کنیم Shift برای انتخاب چند اسلاید متوالی -د 

 کدام روش برای حذف یک اسلاید مناسب است؟ .63

 .زنیمرا می Erase در پنل اسلایدها روی اسلاید مورد نظر راست کلیک می کنیم و گزینه -الف 

 .فشاریمکیبورد را می End پنل اسلایدها روی اسلاید مورد نظر کلیک می کنیم و دکمهدر  -ب 

  .فشاریمرا می Delete گزینه slide و گروه Home در سربرگ -ج 

 .فشاریمکیبورد را می Delete در پنل اسلایدها روی اسلاید مورد نظر کلیک می کنیم و دکمه -د ✅

 اسلایدهای کپی و یا بریده شده کدام راه مناسب نیست؟برای چسباندن اسلاید یا  .64

 Paste و زدن گزینه Sorter Slide یا Normal راست کلیک در فضای خالی اسلایدها در نمای -الف 

 Paste و انتخاب گزینه Clipboard گروه Home رفتن به سربرگ -ب 

 v+ctrl استفاده از کلیدهای ترکیبی -ج 

 ✅ Replace و انتخاب گزینه Clipboard گروه Home رفتن به سربرگ -د 

در صورتی که بخواهیم تم انتخابی را روی همه اسلایدها اعمال کنیم با راست کلیک بر روی تم مورد نظر کدام  .65

 گزینه مناسب است؟

 ✅ Apply to all slides - الف

 Apply to selected - ب

 Set as default theme - ج

 Add gallery to quick access toolbar - د

 های انتخابی را به عنوان تم پیش فرض تعیین کنیم کدام گزینه مناسب است؟در صورتی که بخواهیم تم .66

 Apply to all slide - الف

 Apply to selected slides - ب

 ✅ Set as default theme - ج

 Add gallery to quick access toolbar - د

 شده فقط بر روی اسلایدهای انتخابی اعمال شود کدام گزینه مناسب است؟ در صورتی که بخواهیم تم انتخاب .67

 Apply to all slide - الف

 ✅ Apply to selected slide - ب

 Set as default theme - ج

 Add gallery to quick access toolbar - د

 ام گزینه را انتخاب می کنیم؟ها به نوار ابزار دسترسی سریع اضافه شود کددر صورتی که بخواهیم گالری تم .68

 Apply to all slide - الف

 Apply to selected slide - ب

 ✅ Add gallery to quick access toolbar - ج

 Set as default theme - د

 .زمینه اسلاید از سربرگ ....... گروه ....... و زیر گروه ....... را انتخاب می کنیمبرای تغییر رنگ پس .69

 Design > Variants > Colors - الف

  Design > Variants > Background styles - ب

 Design > Customize > Format background - ج✅

 Design > Themes - د

 Format یزمینه با ترکیب دو رنگ متفاوت باشد گزینه ....... را در پنجرهدر صورتی که بخواهیم رنگ پس .70

background کنیم؟عال میف 

 Slide fill - الف
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 ✅ Gradient fill - ب

 Pattern fill - ج

 Picture and texture fill - د

 شود؟چه زمانی استفاده می background Format یدر پنجره fill Pattern از گزینه .71

 زمینهبرای استفاده از تک رنگ برای رنگ پس -الف 

 ✅ زمینهفزار در رنگ پسابرای استفاده از الگوهای خاص نرم -ب 

 زمینهبرای ترکیب دو رنگ متفاوت برای رنگ پس -ج 

 زمینهبرای استفاده از تصویر و فایل دلخواه به عنوان پس -د 

 شود؟به چه منظور استفاده می background Format یدر پنجره Transparency خاصیت .72

 زمینهتغییر مکان پس -الف 

 ✅ زمینهتغییر شفافیت پس -ب 

 زمینهتغییر رنگ پس -ج 

 زمینهتغییر ابعاد پس -د 

 . ........ توانیممی master Slide در طراحی اسلاید اصلی در ابزار .73

 ✅ .زمینه اسلایدهای فایل ارائه مطلب را مشخص کنیمنمای ظاهری، موقعیت عناصر و پس -الف 

 .رودرای حاضرین در جلسه به کار میبرای طراحی الگوی نسخه چاپی اسلایدهای فایل ارائه مطلب ب -ب 

 .گیرددهنده اسلایدهای فایل ارائه مطلب مورد استفاده قرار میبرای تعیین نمای ظاهری نکات ارائه -ج 

 .توان ایجاد کرددر طراحی اسلاید اصلی هیچ تغییری نمی -د 

 شود؟یک اسلاید استفاده میبه منظور بازنشانی تمام تنظیمات  Slides گروه Home از این ابزار در سربرگ .74

 ✅ Reset - الف

 Layout - ب

 Selection - ج

 New slide - د

 شود؟برای بخش بندی اسلایدها استفاده می Slide و گروه Home از این ابزار در سربرگ .75

 Reset - الف

  Layout - ب

 Section - ج✅

 New slide - د

 تر است؟ود کدام گزینه مناسبدر صورتی که بخواهیم عنصری در یک اسلاید انتخاب ش .76

 Select - الف

 Select all - ب

 ✅ Select object - ج

 Select pane - د

 شود؟به چه منظور استفاده می pane Selection از ابزار .77

 ✅ انتخاب یک نگهدارنده یا مخفی کردن آن -الف 

 انتخاب کل متن اسلایدها -ب 

 انتخاب یک عنصر از اسلاید -ج ✅

 تصاویرانتخاب  -د 

کنیم کدام گزینه را  PowerPoint افزاروارد نرم Excel افزاردر صورتی که بخواهیم جدولی را از محیط نرم .78

 کنیم؟انتخاب می

 Insert table - الف

 Draw table - ب

 ✅ Excel spreadsheet - ج

 Table - د
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 ر مناسب است؟در صورتی که بخواهیم یک تصویری از اینترنت وارد اسلاید کنیم کدام ابزا .79

 Pictures - الف

 ✅ Online pictures - ب

 Screen shot - ج

 Photo album - د

 کدام گزینه برای اضافه کردن اشکال هندسی مناسب است؟ .80

 ✅ Shapes - الف

 Smart Art - ب

 Chart - ج

 Hyper link - د

 شود؟ه میجهت اضافه کردن تصاویر گرافیکی هوشمند استفاد Insert کدام ابزار در سربرگ .81

 Shapes - الف

 ✅ Smart Art - ب

 Chart - ج

 Hyper link - د

 شود؟جهت اضافه کردن نمودار استفاده می Insert کدام ابزار در سربرگ .82

 Shapes - الف

 Smart Art - ب

 ✅ Chart - ج

 Hyper link - د

 جهت درج یادداشت بر روی اسلایدها مناسب است؟ Insert کدام ابزار در سربرگ .83

 Word art - الف

 Header and footer - ب

  Text box - ج

 Comment - د✅

 جهت درج یک محل تایپ متن بر روی اسلایدها مناسب است؟ Insert کدام ابزار در سربرگ .84

 Word art - الف

 Header and footer - ب

 ✅ Text box - ج

 Comment - د

 بر روی اسلایدها مناسب است؟جهت درج سرصفحه و پا صفحه  Insert کدام ابزار در سربرگ .85

 Word art - الف

 ✅ Header and footer - ب

 Text box - ج

 Comment - د

 شود؟به چه منظور استفاده می Word Art از ابزار .86

 ایجاد تصاویر گرافیکی -الف 

 ✅ ایجاد متن گرافیکی -ب 

 ایجاد یادداشت -ج 

 ایجاد سرصفحه و پا صفحه -د 

 شود؟به چه منظور استفاده می Time and Date از ابزار .87

 ✅ درج تاریخ و زمان -الف 

 درج متن گرافیکی -ب 

 درج یادداشت -ج 

 درج سرصفحه و پا صفحه -د 
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 شود؟به چه منظور استفاده می Number Slide از ابزار .88

 درج تصویر -الف 

 درج اشکال هوشمند -ب 

 ✅ درج شماره اسلاید -ج 

 درج تاریخ و زمان -د 

 . ................ به منظور Object از ابزار .89

 ✅ افزارهای غیر مرتبطهای نرمهایی از داخل حافظه دیسک سخت از قبیل فایلدرج فایل -الف 

اند و به صورت فایل بر روی دیسک های دیجیتال ایجاد شدهافزارها و دوربیندرج تصاویری که توسط نرم -ب 

 سخت قرار دارند

 بعدیدرج متن گرافیکی و سه -ج 

 درج نمودار -د 

 .گیردافزار برای درج ................ مورد استفاده قرار میدر نرم Symbol از ابزار .90

 ✅ های ویژهدرج کاراکترها و علامت -الف 

 درج معادلات ریاضی -ب 

 درج تصاویر -ج 

 درج اشکال هندسی -د 

 .گیردقرار می افزار برای درج ..... مورد استفادهدر نرم Equation از ابزار .91

 های ویژهدرج کاراکترها و علامت -الف 

 ✅ درج معادلات ریاضی -ب 

 درج تصاویر -ج 

 درج اشکال هندسی -د 

 گیرد؟از این ابزار برای درج ویدیو از طریق اینترنت به اسلاید مورد استفاده قرار می .92

 Picture - الف

 ✅ Online video - ب

 Text box - ج

 Audio - د

 شود؟زمینه و سایز اسلاید و غیره استفاده میسربرگ برای طراحی اسلاید، تنظیم رنگ پساز این  .93

 Transition - الف

 Insert - ب

 ✅ Design - ج

 Home - د

 .شودهای عبور اسلاید استفاده میاز سربرگ ................ جهت انتخاب حالت .94

 ✅ Transition - الف

 Insert - ب

 Design - ج

 Home - د

های عبور انتخاب شده در اسلاید مورد نظر پیش نمایشی از حالت Transition ز ابزار .............. در سربرگا .95

 .شودمشاهده می

 Timing - الف

  Effect option - ب

 Transition to this slide - ج

 Preview - د✅

ضافه کنیم از ابزار ........ گزینه اسلاید صدای مورد نظر خودمان را ا Transition در صورتی که بخواهیم به .96

 کنیم؟........ را انتخاب می

 ✅ Sound (other sound) - الف
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 Audio (other audio) - ب

 Sound (loop until next sound) - ج

 Audio (loop until next sound) - د

تعریف کنید که پس از سپری توانید برای برنامه می Timing گروه Transition با انتخاب این گزینه در سربرگ .97

 شدن مدت زمان مشخص شده به صورت خودکار به اسلاید بعدی برود؟

 Apply to all - الف

 ✅ After - ب

 Sound - ج

 Duration - د

 چیست؟ Animation در سربرگ Start عملکرد گزینه .98

 ✅ کندنحوه آغاز شدن انیمیشن را مشخص می -الف 

 کندرا مشخص می Animation افزایش یا کاهش زمان پخش -ب 

 را به تاخیر انداخت Animation توان پخشبا درج زمان مورد نظر می -ج 

 کندانیمیشن را پخش می -د 

 دهد؟را نشان می Animation کدام یک از ابزارهای زیر طول مدت زمان نمایش .99

 Trigger - الف

 Start - ب

 ✅ Duration - ج

 Delay - د

 شود؟زیر با مقداردهی در کادر عددی آن موجب تاخیر در نمایش انیمیشن میکدام یک از ابزارهای  .100

 Trigger - الف

 Start - ب

 Duration - ج

 ✅ Delay - د

 در صورتی که بخواهیم انیمیشن ایجاد شده بر روی عنصر با کلیک ماوس اجرا شود کدام گزینه از .101

Start کنیم؟را انتخاب می 

 Start - الف

 With previous - ب

 ✅ On mouse click - ج

 After previous - د

در صورتی که بخواهیم انیمیشن ایجاد شده بر روی عنصر بعد از انیمیشن قبل از خود اجرا شود کدام  .102

 کنیم؟گزینه انتخاب می

 Start - الف

 With previous - ب

 On click - ج

 ✅ After previous - د

 اسلاید نخست چیست؟ترین روش برای نمایش اسلایدها از سریع .103

 5F -الف ✅

  Shift + F5 - ب

 Ctrl + F5 - ج

 Alt + F5 - د

 شود؟از این ابزار به منظور نمایش اسلایدها از اسلاید جاری استفاده می .104

 Present online - الف

 From beginning - ب
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 ✅ From current slide - ج

 Custom slide show - د

 توانیم به ایجاد یک اسلاید شو سفارشی بپردازیم؟می Show Slide رگبا استفاده از این ابزار در سرب .105

 Present online - الف

 From beginning - ب

 From current slide - ج

 ✅ Custom slide show - د

 شود؟کدام یک از ابزارهای زیر به منظور دسترسی به تنظیمات اسلاید و نمایش آنها استفاده می .106

 ✅ Set up slide show - الف

 From beginning - ب

 From current slide - ج

 Custom slide show - د

 شود؟از این ابزار برای مخفی کردن اسلایدها در حالت نمایش استفاده می .107

 ✅ Hide slide - الف

 Setup slide show - ب

 Record slide show - ج

 From current slide - د

 رود؟زمانبندی هر انیمیشن و اسلاید به کار میکدام یک از ابزارهای زیر به منظور  .108

 Hide slide - الف

 Setup slide show - ب

 Record slide show - ج

 ✅ Rehearse timing - د

 شود؟به چه منظور استفاده می Beginning from recording start از ابزار .109

 ضبط صدا بر روی اسلایدها -الف 

 ✅ آخرین اسلایدضبط صدا بر روی اولین تا  -ب 

 ایجاد زمانبندی -ج 

 های کنترلی صدانمایش دکمه -د 

های ها برای برطرف کردن غلطهای املایی در متن اسلایدها کدام یک از روشدر صورت وجود غلط .110

 املایی مناسب است؟

 بر روی واژه اشتباه Click Double - الف

 Grammar گزینه Review سربرگ -ب 

 ✅ Spelling ینهگز Review سربرگ -ج 

 Translate گزینه Review سربرگ -د 

 کنیم؟ها را فعال میای کدام گزینهبرای نمایش خطوط راهنما و شبکه .111

 Ruler - grid line - الف

 ✅ Grid line - guides - ب

 Ruler - guides - ج

 Note - Ruler - د

 کند؟ش میکدام یک از ابزارهای زیر ابعاد اسلاید را هم اندازه صفحه نمای .112

 ✅ Fit to window - الف

 Zoom - ب

 New window - ج

 Switch window - د

 کند؟از ابزارهای زیر کدام یک برای جا به جا کردن ترتیب شکل هندسی ترسیم شده کمک می .113

 ✅ Arrange - الف
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 Quick styles - ب

 Shape outline - ج

 Shape effect - د

 شود؟به چه منظور استفاده می Arrange گروه Format در سربرگ Rotate ابزار .114

 ✅ چرخش عناصر -الف 

 تراز بندی عناصر -ب 

 گروه کردن عناصر -ج 

 تغییر ابعاد طول و عرض -د 

 Print در صورتی که بخواهیم تمام اسلایدهای فایل ارائه مطلب را چاپ کنیم کدام گزینه را در پنجره .115

 کنیم؟انتخاب می

 ✅ Print all slide - الف

 Print selection - ب

 Print current slide - ج

 Custom range - د

در صورتی که بخواهیم در هنگام چاپ اسلاید، اسلایدها به صورت تمام صفحه چاپ شوند کدام گزینه از  .116

 گزینیم؟را برمی Print layout کادر

 Handouts - الف

 Outline - ب

 Note pages - ج

 ✅ Full page slides - د

ی که بخواهیم اسلایدهای فایل ارائه مطلب همراه با نکات آن چاپ شود کدام گزینه را انتخاب در صورت .117

 کنیم؟می

 Handouts - الف

 Outline - ب

 ✅ Note pages - ج

 Full page slides - د

 کنیم؟های هر اسلاید چاپ شود کدام گزینه را انتخاب میدر صورتی که بخواهیم فقط متن .118

 Handouts - الف

 ✅ Outline - ب

 Note pages - ج

 Full page slides - د

 شود؟کدام نما برای ایجاد و طراحی اسلایدها استفاده می .119

 NORMAL - الف✅

  SLIDE SORTER - ب

 NOTE PAGE - ج

 SLIDE SHOW - د

 افزار پاورپوینت است؟کدام گزینه معرف نرم .120

 .افزار گرافیکی استیک نرم -الف 

 ✅ .ارائه مطلب استافزار یک نرم -ب 

 .افزار آماری استیک نرم -ج 

 .افزار صفحه گسترده استیک نرم -د 

 شود؟برای ارائه نهایی نمایش از کدام نما استفاده می .121

 NOTE PAGE - الف

 ✅ SLIDE SHOW - ب
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 SLIDE SORTER - ج

 NORMAL - د

ام اسلاید انجام اجرای برنامه نمایشی از کد SLIDE CURRENT FROM با استفاده از گزینه .122

 شود؟می

 اسلاید اول -الف 

 اسلاید میانی -ب 

 اسلاید آخر -ج 

 ✅ اسلاید جاری -د 

 کند؟در هنگام رسم بیضی فشردن کدام دکمه شکل را به دایره تبدیل می .123

 CTRL - الف

 ALT - ب

 DELETE - ج

 ✅ SHIFT - د

( برنامه قابل اجرا باشد از چه 2003های قبلی )در صورتی که بخواهیم یک فایل ارائه مطالب در نسخه .124

 کنیم؟پسوندی استفاده می

 PPTX - الف

 POT - ب

 ✅ PPT - ج

 PPS - د

 باشد؟قابل انتخاب نمی PowerPoint 2013کدامیک از پسوندهای زیر در برنامه  .125

 POTX - الف

 PPTX - ب

 ✅ TXT - ج

 PPSX - د

 باشند؟میهای اخیراً باز شده قابل رویت در کدام مسیر فایل .126

 Computer ← Open ← File - الف

  One Drive ← Open ← File - ب

 Add a Place ← Open ← File - ج

 Recent Presentation ← Open ← File - د✅

 شود؟کدام گزینه سبب بزرگنمایی اسلاید می .127

 ✅ Zoom In - الف

 Font - ب

 Zoom Out - ج

 Font Size - د

 شود؟های اسلاید از کدام گزینه استفاده میجدید با استفاده از طرحبرای اضافه نمودن یک اسلاید  .128

 New ← File - الف

 Layout ← Home - ب

 Slide master ← View - ج

 ✅ New slide ← Home - د

 کنیم؟زمینه بر روی تمامی اسلایدها از کدام گزینه استفاده میبرای اعمال پس .129

 ✅ Apply to All - الف

 Apply to Select - ب

 Ok - ج

 Cancel - د
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 دهد؟چه اتفاقی رخ می Slide Hide با انتخاب .130

  .سازی دیده نخواهد شداسلاید در نمای مرتب -الف 

 .اسلاید در نمای نرمال دیده نخواهد شد -ب 

 .اسلاید در نمای اجرا دیده نخواهد شد -ج ✅

 .اسلاید در نماهای مختلف دیده نخواهد شد -د 

 کنیم؟جلوه انیمیشن از کدام گزینه استفاده میبرای تکرار اجرای  .131

 Repeat - الف✅

 Delay - ب

 Start - ج

  Duration - د

 شود؟برای انتقال به آخرین اسلاید از کدام کلید میانبر استفاده می .132

  Ctrl + Page Down - الف

 Ctrl + Home - ب

 Ctrl + Page Up - ج

 Ctrl + End - د✅

 باشد؟های نمایش اسلاید نمیز روشهای زیر اکدامیک از گزینه .133

 Notes page - الف

 Normal - ب

 Reading view - ج

 ✅ Template - د

 باشد؟برای ویرایش متن بهترین وضعیت استفاده از کدام نما می .134

 Slide - الف

 Outline - ب

 Slideshow - ج

 ✅ Normal - د

 شود؟برای تعیین محدوده چاپ از کدام گزینه استفاده می .135

 Print Title - فال

 All - ب

 Print - ج

 ✅ Set Print Area - د

 دهیم؟ها را تغییر میبا استفاده از کدام فرمان، ترتیب اجرای انیمیشن .136

 Frame - الف

 Duration - ب

 Delay - ج

 ✅ Reorder Animation - د

 نماییم؟های عملیاتی استفاده میاز کدام گزینه برای درج دکمه .137

 Shapes - الف

 Run - ب

 Begin Type - ج

 ✅ Action Buttons - د

 شود؟جهت چاپ چند اسلاید به صورت کوچک در یک کاغذ از کدام گزینه استفاده می .138

 Frame slide - الف

 ✅ Handouts - ب

 Outline - ج

 Pages - د
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 .فشاریمبرای نمایش اسلایدها از اسلاید جاری، کلیدهای ........... را همزمان می .139

 Alt + F3 - الف

  Alt + F5 - ب

 Shift + F3 - ج

 Shift + F5 - د✅

باعث چاپ  View Outline ، انتخاب گزینهPowerPoint 2019افزار هنگام چاپ یک اسلاید در نرم .140

 کدام یک از موارد زیر خواهد شد؟

 ✅ فقط متن -الف 

 متن و تصاویر -ب 

 فقط تصاویر -ج 

 Notesمتن، تصاویر،  -د 

 کدام است؟ PowerPoint 2019پسوند ذخیره فایل  .141

 ✅ pptx - الف

 ppsx - ب

 ppxt - ج

 ppxs - د

ذخیره شده است، کدام مورد در خصوص این فایل صحیح  PPSX با پسوند PowerPoint یک فایل .142

 است؟

 ✅ قابل ویرایش نیست -الف 

 شودباز می Show Slide بطور معمول در حالت -ب 

 های ویدیویی نیستفرمتیا  PDF قابل تبدیل به فرمت -ج 

 ایجاد شده است PowerPoint های قدیمیبه منظور سازگاری با نسخه -د 

از کدام مورد زیر کمک  PowerPoint 2019جهت ترسیم شکل یا ستاره در یک اسلاید از یک فایل  .143

 گیریم؟می

Insert > Picture - الف 

Insert > WordArt - ب 

Insert > ClipArt - ج 

Insert > Shapes - د ✅ 

اسلاید ایجاد شده است، فرض کنید در حین نمایش بخواهید اسلایدهای  52شامل  PowerPoint یک فایل .144

 ترین راه استفاده از کدام ابزار است؟نمایش داده نشود. مناسب 14و  12، 10

Custom Slide Show - الف 

Setup Slide Show - ب 

Hide Slide - ج ✅ 

From Current Slide - د 

از کدام ابزار کمک  PowerPoint 2019های از پیش آماده به اسلایدهای یک فایل جهت اعمال طرح .145

 شود؟گرفته می

 SmartArt - الف

 ✅ Themes - ب

Slide Master - ج 

 ClipArt - د

 شود؟از اسلاید جاری از کدام مورد استفاده می PowerPoint جهت اجرای نمایش یک فایل .146

 11F -الف 

 5F -ب 

Shift+F5 - ج ✅ 

Ctrl+F9 - د 
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از کدام زبانه استفاده  PowerPoint 2019جهت زمانبندی انتقال از یک اسلاید به اسلاید دیگر در  .147

 شود؟می

 Animation - الف

Slide Show - ب ✅ 

 Design - ج

 View - د

 سازی است؟قابل ذخیره Word با کدام یک از پسوندهای PowerPoint یک فایل .148

 rtf - الف✅

  doc - ب

 dot - ج

 docx - د

توضیحی اضافه کنید از کدام نوع نمایش استفاده  PowerPoint اگر بخواهید برای یک اسلاید در .149

 کنید؟می

Notes page - الف ✅ 

 Outline - ب

Slide Master - ج 

 Normal - د

 چه نوع اسلیدی است؟ PowerPoint بطور معمول اولین اسلاید در یک فایل .150

Title and Content - الف 

Title only - ب 

Title Slide - ج ✅ 

 Blank - د

مورد استفاده قرار  PowerPoint های جایگزینی کدام پنجره دربرای ایجاد حرکت در اسلایدها و جلوه .151

 گیرد؟می

Slide Transition - الف ✅ 

Shared Workspace - ب 

Slide Layout - ج 

Slide Design - د 

 شود؟به کدام منظور استفاده می PowerPoint در محیط Transition ابزار .152

 شروع نمایش یک فایل -الف 

 تبدیل فایل به یک فایل ورد -ب 

 سازی یک نوشته در یک اسلایدمتحرک -ج 

 ✅ نحوه محو شدن یک اسلاید و ظاهر شدن اسلاید بعدی -د 

 
 


